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EXPORT DATA FROM DAISEY 
 

1. Navigate to https://daisey.cete.us/kehs/login, log in, and accept the terms of the 

security agreement (you will have to do this each time you log in). 
 

2. From the homepage, choose Data Management listed in the menu: 
 

 
 

3. From the drop-down menu that appears, choose Export, then Export Data. 
 

 
 

4. Find the data you want to export and click Export. (For this specific tutorial you will 
want to export myIGDIs Literacy+ data). 

 
 

https://daisey.cete.us/kehs/login
https://daisey.cete.us/kehs/login
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5. The message below will pop up asking you to specify a date range. This will limit your 
export to data collected during the specified time frame. Enter the dates of the 
current evaluation year.  

 

Please note: the ECBG evaluation year runs from June 1st to May 31st the following year. 

For example, the 2019-2020 runs from June 1st, 2019 – May 31st, 2020. Therefore, you 

would put June 1st, 2019 as the “Start Date”.  If you do not specify a date range, all 

data that has ever been entered for that measure into DAISEY will be exported.  

 

 
 
 

6. Once you specify a date range, click Continue to export the data without the profile 

data included or click Export with Profile if you would like profile data as well. 
 

NOTE: While the records are exporting, “In Progress” will appear next to the item. This 

normally takes a few moments, and you can navigate to other DAISEY pages to work 
while it exports. 

 
 

7. When the download is ready, “Completed” will appear next to the item. Click on 
“Completed” and the export will download as an Excel spreadsheet. 
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CREATE A PIVOT TABLE TO COUNT NUMBER OF CHILDREN ASSESSED WITH myIGDIs LITERACY+ 

 

8. Select Rows 1 and 2 by clicking on 1 and dragging to Row 2. They should be 

highlighted indicating they are selected.  
 

 
 

9. Go to the upper right-hand side of the screen, and click the button that says Delete.  
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10. Repeat step 8, now selecting Rows 2-5 (“Question Data Type, Question Format Type, 
Question Response, and Question Mandatory should all be selected). Again, once 
those rows are selected it will be highlighted. 

 

 
 

11. Repeat step 9, and delete the selected rows. Again, this can be done by going to the 

upper right area of your Excel sheet and clicking on the Delete button. 
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12. After steps 8-11, your Excel sheet should be a replica of the below screenshot. Row 1 
should be as follows: Question Label, Grantee, Organization, Program, Child ID, etc. 
 

 
 

13. Select Column E, which should be labeled as Child ID. The entire column should be 
highlighted, indicating the entire column is being selected.  
 

 
 

14. Click on the tab at the top left side of the spreadsheet labeled Insert.  
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15. Once the tab is clicked, a new row of options will appear across your Excel sheet. It 
should contain some of the same options as in the screenshot below (depending on 
what version or Excel you are currently running). 

 

 
 

16. Click on Pivot Table. It will most likely be the very first option at the very right of these 

options under the Insert tab. 
 

 
 

17. A Create Pivot Table box will pop up. It lists some options, but it always defaults to 
"Select a table or range." The Table/Range will already be filled out for you. 

Click OK on the bottom left of the box.  
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18. Excel has now made you a new Sheet. Your new sheet will have the beginnings of your 
PivotTable on it, as pictured below. Locate the PivotTable Fields box on the right-hand 

side of your Excel screen. In the top box it should only say Child ID.  

 

 
 

19. Mark the box next to Child ID. Select and drag Child ID down into the box that 

says Rows. You will notice your PivotTable on the left-hand side of your Excel sheet has 

changed. It should now say Row Labels and have Child IDs listed under that column. 
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20. Select Child ID once again, and drag it to the box that says Values. It will change the 

name from Child ID to Count of Child ID in the Values box. Your table on the left should 

now have two columns: Row Labels and Count of Child ID. The Row Labels column is 

every child by DAISEY ID with data, while the Count of Child ID column is the number of 
rows of data submitted for each child. 
 

 
 

NOTE: Make sure it says “Count of Child ID” in the Values box and for the title of the second 
column in your PivotTable. If it says something other than “Count”, follow the steps below: 

• In the Values box, click the drop down arrow. Then click Value Field Settings… from 

the listed available options. 

              
 

• The below Value Field Settings box will pop up. Click the Summarize Values By tab, 

select Count from the list, and then click OK. 
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21. At the bottom of your PivotTable is a blue highlighted row that says Grand Total. It is 
easy to look at this and assume that (based on the example below) 174 children have 

been assess. This is not the case!  This is counting the number of rows of data each 

child has submitted for them, not the number of children assessed. 
 

 
 

22. In order to find the actual number of children assessed, we need to count the number 

of Child IDs listed under the Row Labels column. In an empty cell below the table type 

“=COUNTA” and a box, like the one pictured below, should pop up. Click “COUNTA” 

under Functions. (NOTE: If the box does not appear, you will have to type out the full 

formula “=COUNTA(“ yourself.) 
 

 
 

23. Once selected (or typed out), the box will look like this: “=COUNTA(“. It is asking us to 
now put in values.  
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24. To get the correct count of children assessed, click on the first Child ID under Row 

Labels and drag/select down to the last Child ID listed. Do not include the (blank) 

row! Now, after making your selection, press the Enter key on your keyboard.  
 

 
 

 
25. The number calculated in the cell indicates the number of children assessed.  
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26. If you want to get an idea of how many children had the required number of 
repeated measures, type “=COUNTIF” in an empty cell. A box, like the one pictured 

below, will pop up. Click “COUNTIF” under Functions. (NOTE: Again, if the box does not 

appear, you will have to type out the full formula “=COUNTIF(“ yourself.) 
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27. Once selected (or typed out), the box will look like this: “=COUNTIF(“. It is asking us to 
now put in values.  
 

 
 

28. Highlight the numbers under the Count of Child ID column by selecting the first number 

and drag down to the last number listed. Again, there is no need to include the 

(blank) row in this selection! 
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29. This is a ‘COUNT IF” option, meaning it will only count certain values if they meet a 

specific criterion. We need to add to the formula in the Formula Bar at the top of the 
Excel sheet. It should already say “=COUNTIF(B4:B17”.  

a. In this example, we are using end of year exported myIGDIs Literacy+ data from 
DAISEY and wanting a rough count of children who have been assessed with all 
subtests of the myIGDIs Literacy+ in the fall, winter, and spring.  

b. Each individual subtest for a child is entered into DAISEY separately. This means if 
a child received all appropriate subtests in the fall (4 subtests), winter (5 

subtests), and spring (5 subtests) then they will have at least 14 lines of data 
total.  

c. Therefore, we need to tell the formula to only count children with 14 or more 

lines of data. It should say “=COUNTIF(B4:B17, “>=14”)”. Once that is typed in 

the Formula Bar, press Enter on your keyboard.  
 

 
 

NOTE: As previously stated, this example utilizes end of year myIGDIs Literacy+ data and looks 
at children who had the assessment completed for all testing seasons (fall, winter, and 
spring). However, if you are looking at exported Literacy+ data after the fall or winter 
administration windows, you will need to alter your formula.  

 

• After fall administration, you will enter “=COUNTIF(B4:B17, “>=4”)” since there should be 

4 lines of data per child after fall administration (4 subtests).  
 

• After winter administration, you will enter “=COUNTIF(B4:B17, “>=9”)” since there should 

be 9 lines of data per child after winter administration (4 subtests in the fall and 5 in the 
winter). 

 

• Also note, there may be duplicates in your data, resulting in more lines of data per 

child. If this is the case, you will need to complete the next section of instructions to 
look into this further. 
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30. After you have completed the appropriate formula, you should see a number in the 
box with the total number of children which meet the specific criteria you specified in 
the formula.  

 

 
 

 

Formulas for myIGDIs Numeracy data: 
 

This tutorial can also be applied to myIGDIs Numeracy data. The formulas to use in step 29 for 
Numeracy data are as follows: 
 

• After fall adminstration, you will enter “=COUNTIF(B4:B17, “>=4”)” since there should be 

4 lines of data per child after fall administration (4 subtests).  
 

• After winter administration, you will enter “=COUNTIF(B4:B17, “>=8”)” since there should 

be 8 lines of data per child after winter administration (4 subtests in the fall and 4 in the 
winter). 
 

• After spring administration or for end of year data, you will enter “=COUNTIF(B4:B17, 

“>=12”)” since there should be 12 lines of data per child after spring administration if 
they received the assessment at all three points in time (4 subtests in the fall, 4 in the 
winter, and 4 in the spring). 

 

 

Please feel free to stop here! The following steps will give you a more detailed breakdown of 

what subtests (in this example we continue to use myIGDIs Literacy+ data: Alliteration, 

Picture Naming, Rhyming, Sound Identification, and WODB) by season (fall, winter, or spring) 

have been entered into DAISEY for each child.  
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PIVOT TABLE OF SUBTESTS BY SEASON ENTERED FOR EACH CHILD INTO DAISEY 
 

31. Go back to the Data tab. Select Column E (Child ID) through Column M (Testing 

Season). To do this, click on Column E at the very top, and select/drag until you get to 

Column M. All of the columns selected should be highlighted.  
 

 
 

32. While the columns are highlighted, click on the Insert tab in the upper left-hand side of 

your Excel screen. The following will show up again, and you will want to select the 

PivotTable option. 
 

 
 

33. A Create Pivot Table box will pop up. Select OK and your PivotTable will appear on a 
new tab. 
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34. For this PivotTable, you may notice the top box includes multiple options now. First, 

mark the box next to Child ID. Select and drag Child ID down into the box below Rows. 

Your PivotTable on the left should now say Row Labels and have Child IDs listed. 

 

 
 

35. Now select and drag myIGDI Early Literacy + Sub Assessment Name into the Rows 
box. (You may have to scroll down in the top box to find this option.) Literacy+ subtests 
should have appeared under each Child ID in your PivotTable on the left. 
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36.  Lastly, select and drag Testing Season first under the Rows box, and then again under 

the Values box. 
 

 
 

NOTE: Make sure it says “Count of Testing Season” in the Values box and for the title of the 
second column in your PivotTable. If it says something other than “Count”, follow the steps in 
the NOTE section under step 20 above. 
 

37. In your PivotTable on the left, you can now see which subtests by season each child 
has had submitted into DAISEY. 
 

 
 

NOTE: This section of the tutorial can also be applied to myIGDIs Numeracy data. 


